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PREFACE

Welcome to the Oracle Insurance Insbridge Enterprise Rating Installation Guide. The Insbridge
Enterprise Rating (Insbridge) System is a browser-based, multiplatform insurance rating and
underwriting technology solution that provides integrated management for every aspect of the
rate definition and modification process. This guide assists with the installation of the Insbridge
Enterprise Rating System.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the Insbridge system and associated databases.

PLANNING YOUR INSBRIDGE SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added
later on. The Oracle Insurance Insbridge Enterprise Rating system (Insbridge) is expandable and
can accommodate a few different configurations.

For more on planning your Insbridge system, please see the Insbridge Implementation Guide.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

¢ RateManager for Windows — Installs RateManager and the Insbridge Framework
Administrator (IBFA) in a Windows environment and utilizes IBFA for local rating. This
Windows only environment uses a SQL Server database.

SoftRater Installation

o SoftRater for Java Installation — Deploys Insbridge SoftRater Server (IBSS) to an
application server; WebLogic, WebSphere or JBoss, using a SQL Server database, or an
Oracle database, or a DB2 database.

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 6
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e SoftRater for Windows Node — This installation is for existing environments that want to
add a SoftRater for Windows node to an environment. This is for a Windows only
environment using a SQL Server database.

Upgrading a Current Installation

o Upgrade — Upgrades existing customers from their current version of Insbridge up to
version 05.06.00.

This guide is for a RateManager installation.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Enterprise
Rating system:

e IBER - Insbridge Enterprise Rating System. Most often referred to as Insbridge. This is
the entire system.

e IBFA - Inshridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

e IBSS - Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within Insbridge that
executes the rules, rating and underwriting instructions as defined by the user in
RateManager. IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge
SoftRater Server/SoftRater for Java.

o SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

¢ RM - RateManager. RateManager is a component within Insbridge that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

¢ SR - SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

e SR-WIN - SoftRater for Windows. This is also another name for IBFA.

¢ SR-JAVA - SoftRater for Java. This is also another name for IBSS.

o SRP - SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

e VFS - Virtual File Servers. Virtual file server management allows you to access

environments that are located on other machines in different locations where packages
can be downloaded.
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e Package Location — A pointer to a location where SoftRater Packages (SRP’s) are
stored.

e Physical Environment — A physical environment is generally referred to as a physical
machine.

e Authoring Environment — The physical machine where RateManager is installed.

e Rating Environment — The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

e Logical Environment — An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other

supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

RELATED DOCUMENTS

For more information, refer to the following Oracle resources:

e The Oracle Insurance Insbridge Enterprise Rating Operating Environments for Hardware
and Software.

e You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

CONVENTIONS

The following text conventions are used in this document:

Convention  Description

Boldface type indicates graphical user interface elements associated

el with an action.

Italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

R Monospace type indicates commands within a paragraph, URLS, code

in examples, text that appears on the screen, or text that you enter.

Guide History

New editions incorporate any updates issued since the previous edition.
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Chapter 1

SYSTEM REQUIREMENTS

Insbridge installers should be familiar with managing a Windows server.

Required Components

The following components, web server roles, and features are required:
e Afull installation of Microsoft Windows Server 2008 or 2008 R2 or 2012 or 2012 R2 or 2016
e Microsoft .NET Framework version 4.6.2 for Windows Server 2016 only

e Microsoft .NET Framework version 4.5.2 with .NET 3.5.1 feature activation
e |IS: Internet Information Services version 7.0 or 7.5 or 8.0 or 8.5 0r 10

o Web Server Role — IS 6 Metabase Compatibility
e Web Server Role — (lIS) Static Content
e Web Server Role — ASP.NET

¢ MSMQ - Microsoft Message Queuing Services, basic functionality only.

e Insbridge User Account

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where Insbridge will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where Insbridge documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Support.

The installation downloads you can select are:

¢ Insbridge-Windows — Required for all RateManager installations. The Insbridge installation is for
a 64-bit system.

e Insbridge-WebSphere-eng — Required if you are using WebSphere

e Insbridge-WebLogic-eng — Required if you are using WebLogic
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e Insbridge-JBoss-eng — Required if you are using JBoss

e Documentation — It is recommended that you download the documentation. Installation guides
are located here.

The Insbridge-Windows folder contents:

- Databases
¢ SQL Server
- 2008
- RateManager — IBRM
o Latinl_General_BIN
» DATABASE_BACKUP_IBRM_TEMPLATE.bak
o SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
o SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB _CLIENT_TEMPLATE.bak
- SoftRater — IBSR
o Latinl_General_BIN
» DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latinl General CP1_CI_AS
» DATABASE_BACKUP_IBSR_TEMPLATE.bak

- 2012
- RateManager — IBRM
o Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
o SQL_Latinl General CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater — IBSR
o Latinl_General_BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak

- 2016
- RateManager — IBRM
o Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latinl General CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
o SQL_Latinl General CP1_CI_AS
= DATABASE BACKUP_IB CLIENT_TEMPLATE.bak
- SoftRater — IBSR
o Latinl_General_BIN
= DATABASE BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latinl_General_CP1_CI_AS
= DATABASE BACKUP_IBSR_TEMPLATE.bak
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- Oracle Bl Publisher
¢+ OBI_PUBLISHER.exe

- Oracle Client
¢ ODAC121012_x64.zip

- Oracle Insurance Insbridge Enterprise Rating (x64).exe
You are required to run the installation file and create the IB_CLIENT database for any new installation.
The other folders and files may not be needed, depending upon the kind of setup you want. Everything for
a Windows only installation is in the 05.06.00-Insbridge-windows folder. If you want to incorporate a

Java environment, please download the corresponding SoftRater file. SoftRater downloads are not
required if you are running in Windows only.

Internet Explorer

IBSS and IBFA are accessed via web browser. Please verify that you are using Internet Explorer 11*.

* Run in Compatibility mode
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Quick View

RATEMANAGER INSTALLATION

Installing RateManager requires that you:
1. Setup Windows. There are a few steps in setting up a RateManager deployment.

2. Install Insbridge using a SQL Server Database.

Setting up Windows

Step 1: Set up an Insbridge User.

Step 2: Verify or activate Windows Server web server roles.

Step 3: Allowing for WCF Services.

Step 4: Verify or install .NET 4.5.2. Windows Server 2008 and 2012 only.

Step 5: Verify SQL Server settings.

Installation Procedures: Full RateManager

Step 1: Install Insbridge Enterprise Rating

Step 2: Configuring Registry Access

Step 3: Verifying the Insbridge Application Pool

Step 4: Assigning Permissions: Windows Temp Folder
Step 5: Assigning Permissions: Insbridge Folder

Step 6: Restoring Insbridge Databases in SQL Server
Step 7: Configuring Insbridge Framework Administrator
Step 8: Verifying the Component Services

Step 9: Installing the OBI Publisher

Step 10: Starting Insbridge Services

Step 11: Performing Updates in RateManager

Step 12: Export Insbridge Registry Key for Backup
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SETTING UP WINDOWS

Insbridge installers should be familiar with managing a Windows server.

Windows Server should be up and running prior to RateManager being installed. There are a few steps
that should be performed prior to the install:

e Step 1: Set up an Insbridge User. This is a required step.

e Step 2: Setting Windows Server web server roles.

e Step 3: Verify or install Windows Server features.

e Step 4: Verify or install .NET 4.5.2. Windows Server 2008 or 2012 only

e Step 5: Verify SQL Server settings.

ADMINISTRATIVE USER ACCOUNTS

No administrative account is created when Insbridge is installed. An administrative user account must be
created on the server where the Insbridge system is going to be installed. This required account is the
Insbridge Local User Account.

The Insbridge Local User needs to be a member of the User group and requires certain privileges in order

to fully control the entire Insbridge environment. For ease of installation and if the server is dedicated to
the Insbridge Enterprise Rating System, this user can be added to the local machine Administrators

group.

FILE PERMISSIONS

The Insbridge User requires read/write permissions on:
e The Windows Temp Folder. This is necessary for MSMQ.
e The Insbridge Application Pool Identity

e The Insbridge Folder

The Insbridge user must also be given full control over the following registry key:

e HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
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Chapter 2 — Setting Up Windows

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.

Insbridge User Password

The password can be set to any password that meets your company standards. The Insbridge
administrator must make note of the password for future configuration.

For ease of maintenance, the Insbridge user should not have to change the password and the password
should never expire.

The installation automatically applies the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This
recreates the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password.

Installer Permissions

The installation program requires that the installer have administrator rights on the machine where the
install is occurring. The install must be run as administrator.

NOTE: If the Installer has permissions, an Insbridge User account can be created from within the install.
If you create an Insbridge user from the install, you may not be able to set the permissions you
need. Please be sure to verify the proper permissions are in place before continuing.

Default Language and RM Locale Settings

The initial installation of Insbridge uses the default language of the server where Insbridge is being
installed. For example, if the default language is EN-US, then Insbridge will use that setting. If the default
language is updated but RateManager is not reflecting the change, please verify that the .NET
Globalization setting on the Insbridge, RM, and IBFA sites in 1IS have been updated.
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DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the Insbridge databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Enterprise Rating System will fail. An experienced database administrator’s expertise is highly
recommended before making any security changes.

An ibru account must be created for the Insbridge application.

Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have:

e A database owner (db_owner) role. db_owner access is needed to execute the Insbridge
stored procedures and have full access to the Insbridge schema.

e Disk Admin permissions are also recommended in order to create backups within
RateManager.

Database Location:

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, the database will
need to be updated manually. If disk admin permissions are not allowed, backups will have to be done
outside of RateManager.

NEW IB_CLIENT and IBRM Databases — Files are located in the download file available on Oracle
Software Delivery Cloud. Template files are current.

UPDATING IB_CLIENT and IBRM Databases — The preferred method of updating the IBRM, and
IB_CLIENT databases is to run them through RateManager. If the RM administrator has DB User
privileges and is the DB Owner of the database as well as the disk administrator, database updates can
be done on the Tools>Database—>Updates tab. If these privileges are not in place, an error message is
displayed.

These databases can be updated manually by downloading the scripts and running directly in SQL
Server. Scripts must be run in sequential order. You must have SQL SERVER permissions.

New IB_CLIENT and IBRM database updates are usually not required.
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STEP 1: INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being
installed.

To Create a New User:

1. Select Start->Administrative Tools->Computer Management.
2. Select System Tools—>Local Users and Groups.
3. Select Users.

4. Right click and select New User.

X Computer Management = || =] =
File Action View Help
es 26 o 0E
A Computer Management (Local|| Name Full Name Description Actions
A [[’,E System Tools A Administrator Built-in account for administering... Moers -
4 @ Task Scheduler ey dev Sys Admin Account More Act ,
b 2] Event Viewer ) Guest Built-in account for guest access t.. ore Actions
I @l Shared Folders 2
4 i Local Users and Groups New User :
| Users -
% Groups User name: |Insbndge |
4 @’\ Performance Full name: ||nsbridge User |

= Device Manager

4 |23 Storage Description: ||nsbridge User |

Is ‘&9 Windows Server Backug
:=F Disk Management

I ::(3 Services and Applications Password:

Corfirm password:

User must change password at next logon

User cannot change password

[] Accourt is disabled

Help Create

| Close

Figure 1 Creating New User

5. Add a new Insbridge user. Enter user name and password information. Uncheck User must
change password at next logon. Check User cannot change password and Password never
expires.

6. Click Create.

7. Close the Add New User screen and select the Insbridge user. Right click and select Properties.
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8. The Insbridge User should be assigned to the local Users group and have the same permissions
as the internet guest account.

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user
cannot be a part of the local administrators groups, please make sure that the Insbridge user has
permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.

Insbridge Properties _

Remaote control I Remote Desktop Services Profile Dialdin
General | Member Of | Profile | Environment Sessions
Member of
& Administrators
& Users

Changes to a user’s group membership

Remove are not effective urtil the next time the

user logs on.

OK || Cancel Apply Help

Figure 2 Adding User information

9. Click OK. Please keep the Insbridge user information close at hand. You will need it for the
installation.
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STEP 2: WINDOWS SERVER WEB SERVER ROLES

Activate/install or verify that certain web server roles are in place prior to running the install.
e Web Server Role: IIS 6 Metabase Compatibility
e Web Server Role: (IIS) Static Content

o Web Server Role: ASP.NET

[ Server Manager = | = -

@ *  Server Manager > All Servers Marage  Tools

I8 Dashboard Available Memaory

B Local Server

#5 Al Servers Filter ye

E App Server

= . . Sarver‘ha”ns Counter Status  CPU Alert Count  Memory Alert Count  First Occurrence  Last Occurrence
WE File and Storage Services b o

e s Win1100000 Off

ROLES AND FEATURES

All roles and features | 78 tota

_ Add Roles and Features
Filter » -E/‘ v '—qf' M Remove Roles and Features
Server Name  Name Type Path Refresh
Win1100000 Application Server Role Application Server -
Win1100000 Windows PowerShell ISE Feature Windows PowerShell\Windows PowerShel
Win1100000 Windows PowerShell Feature Windows PowerShell
Win1100000 SMTP Server Tools Feature Remote Server Administration Tools\Featy
Win1100000  Feature Administration Toals Feature Remote Server Administration Tools\Feat =
‘Win1100000 Remaote Server Administration Tools Feature Remote Server Administration Tecls v
< " >

Figure 3 Windows Server Web Server Roles

If web service roles are not listed or activated, please add before installing Insbridge.
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STEP 3: ALLOWING FOR WCF SERVICES

WCF Services is required for web services. RateManager makes calls using IBFA web services. If this is

not activated, users will experience errors.

In Windows Server 2008, this feature is WCF Activation.

1. Select Start->Administrative Tools—> Server Manager.

2. Scroll through the Roles and Features to verify WCF Services has been installed.

[= Server Manager

@ -

Server Manager * All Servers

IZ8 Dashboard

B Local Server

e c - (=)
H& All Servers Filter el @@ -

E App Server

Available Memory

ii File and Storage Services P

e us Win1100000 Off _ i}

et -
(H) - ()
® ~

-
Server Name Counter Status  CPU Alert Count  Memory Alert Count  First Occurrence  Last Occurrence

Manage Tools

-@1F

ROLES AND FEATURES

All roles and features | 78 total

= —
[ ] { ]
I? i) .

Server Name

Win1100000
Win1100000
Win1100000
Win1100000
Win1100000

Win1100000
<

Name

URL Authaorization

User Interfaces and Infrastructure
WCF Services

Web Server

Web Server (lIS)

Web Server (lIS) Support

Type

Role Service Web Server (IIS)\Web Server\Security\URL ™

Feature

Feature

Role Service Web Server (IIS)\Web Server

Role

Role Service Application Server\Web Server (lIS) Suppo .,

Path

User Interfaces and Infrastructure

.NET Framework 4.5 Features\WCF Service]

‘Web Server (IIS)

¥

Figure 4 Verifying WCF Services

3. If not, select Tasks>Add Rolls and Features.

4. Follow the prompts and select WCF Services.
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Select features

Before You Begin
Installation Type
Server selection

Server Roles

Select one or more features to install on the selected server.

Features

A MET Framework 4.5 Features (Installed)
NET Framework 4.5 (Installed)
ASP.MET 4.5 (Installed)

| CF Senvices (Installed

HTTP Activation (Installed)

Message Queuing (MSMQ) Activation (Insy
Named Pipe Activation (Installed)

TCP Activation (Installed)

TCP Port Sharing (Installzd)

l>_|:| Background Intelligent Transfer Service (BITS)

[] BitLocker Drive Encrypticn

[] BitLocker Metwork Unlock

[] BranchCache

[] Client for NFS

<]

DESTIMATION SERVER
ras32671170ws.oracle.com

Description

Windows Communication
Foundation (WCF) Activation uses
Windows Process Activation Service
to invoke applications remotely over
the network by using protocols such
as HTTP, Message Queuing, TCP,
and named pipes, Consequently,
applications can start and stop
dynamically in response to incoming
work items, resulting in application
hosting that is more robust,
manageable, and efficient.

| | Cancel

Install

Figure 5 Selecting WCF Services

5. Confirm your selection and click Install. The installation will proceed.

6. Close out when complete.
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STEP 4: VERIFY OR INSTALL .NET 4.5.2

This step is for Microsoft Windows Server 2008 and Windows Server 2012. If you are using Microsoft
Windows Server 2016, you can skip this step. Windows Server 2016 comes with .NET 4.6.2.

.NET 4.5.2 requires .NET 3.5.1 features to be installed prior to installing .NET 4.5.2. Failure to use .NET

4.5.2 results in errors when accessing IBFA.

1. To verify .Net 4.5.2, select Run from the Start Menu.

2. Type regedt32. Click OK. The Registry Editor will open.

3. Browse to HKEY_LOCAL_MACHINE->SOFTWARE->Microsoft>.NET Framework

Setup>NDP->v4->Full.

£ Registry Editor

File Edit Wiew Favorites Help

- Metwork

) MetworkaccessProtectic
----- . Mon-Driver Signing

H-- | Mokepad
H- | ODBC

H- | Cffice

) Ole

#-- |, Outlook Express
|- L PLA

#- | PowerShell
2}

2}

2}

2}

)

e
=

. Print

- . RADAR

- . Ras

- |, Reliabilivy Analysis

- . RemovalTools
-
1| | B

o T O e O O O O o O e O oy B e R

- | Internet Explorer ;I Mame Type | Data |
Bl L MMC ab]{Default) REG_SZ {value nat set)
- | Mobile 7] Install REG_DWORD 000000001 §1)
- MosTrace ab|InstallPath REG_SZ C:ywindowsiMicrosoft NET\Frameworkeev4,0,30319)
F- | M3Euild BEG DiWORD (300000001 (1)
By MSDE REG_DWORD 0x0005chFS (379693) |
By MSDTC We|nervicing FEG_DWORD UL
G- MSF_ ) ab)Targetyersion REG_SZ 4,0,0
-, Malicsnsing b yersion REG_SZ 4,5,51209
[ MSMO -
[#]- | M350LServer
[+ b NEPServer
[l | MET Framewark Setup
B |, MDP
| CDF
| w2.0.50727
. w30

|C0mputer'l,HKE\"_LOCAL_MACHINE'l,SOFTWARE'!,MicrosoFt'l,NET Framewark SetupiMDP w41 Full

Figure 6 Verifying .NET 4.5.2 in Registry

4. The release number should read 379893. If the number is smaller or the Full folder is not
present, .NET 4.5.2 has not been installed. Make sure to look at the v4 folder. DO NOT look

at v4.0.
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5. If NET 4.5.2 is installed, close out the registry and continue.

6. If NET 4.5.2 is not installed, you must install before you can continue. .NET 4.5.2 must be
installed prior to running the Insbridge installation. .NET 4.5.2 requires .NET 3.5.1 features to be
installed prior to installing .NET 4.5.2. Make sure .NET 3.5.1 is installed prior to installing .NET
4.5.2.

NOTE: .NET 4.5.2 is not included with the Insbridge installation. The .NET 4.5.2 download can be
obtained from Microsoft.

Troubleshooting

If you receive an error when accessing IBFA:
Could not load type 'System.ServiceModel.Activation.HttpModule' from

assembly 'System.ServiceModel, Version=3.0.0.0, Culture=neutral,
PublicKeyToken=b77a5c561934e089

This error may happen when there are multiple versions of .NET Framework on a machine that is running
IIS and did not get registered properly.

Please see http://msdn.microsoft.com/en-us/library/hh169179(v=nav.71).aspx for more information.
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STEP 5. MICROSOFT SQL SERVER

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the Insbridge web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.

Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication — Should be set to SQL Server and Windows Authentication mode.

e Collation and Sort Order — Currently supported is the default SQL Server collation using
SQL_Latinl_General_CP1_CI_AS and sort order plus case sensitivity using Latinl_General_BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latinl_General_CP1_CI_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
guestions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.

Compatibility Level

The compatibility level for Microsoft SQL Server:
e 2012=110
e 2016 =130

“For all installations of SQL Server 2012, the default compatibility level is 110. Databases created in SQL
Server 2012 are set to this level unless the model database has a lower compatibility level. When a
database is upgraded to SQL Server 2012 from any earlier version of SQL Server, the database retains
its existing compatibility level if it is at least 90. Upgrading a database with a compatibility level below 90
sets the database to compatibility level 90. This applies to both system and user databases. Use ALTER
DATABASE to change the compatibility level of the database. To view the current compatibility level of a
database, query the compatibility level column in the sys.databasescatalog view."!

1 https://msdn.microsoft.com/en-us/library/bb510680(v=sql.110).aspx, Microsoft Developer Network,
2015.
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Chapter 3

FULL RATEMANAGER INSTALLATION

This installation installs RateManager and the Insbridge Framework Administrator (IBFA). This is for a
Windows only environment, using a SQL Server database.

DEVELOPMENT
Before installing, please verify that the system requirements are in place.
Rating and Rules
Authoring
The installation should be performed in the following order:
. . . INSTALL:
1. Install the Insbridge application. A
2. Assigning Insbridge access to the Registry. OBl rfmisher
3. Verify the Insbridge Application Pool. S CREATE
4. Assigning permissions to the Insbridge User for the Windows Mustoe e same
Temp Folder. This is necessary for MSMQ. You also need to
assign permissions to the Application Pool Identity. ADD

DB Connections:
5. Assigning permissions to the Insbridge User for the Insbridge

Controller
Folder. Sequrity
RM
6. Creation of the Insbridge databases is next. There are two
databases that must be in place.
CREATE:
a. IB_Client Logical
Environments:
b. IBRM
RM — to hardle
7. Enter IBFA and Configure: ket
3 QA_SR - This
a. Create your subscriber. environment
contains the full
b. Add database connections. ﬁiﬁ’::f;tga
8. Verifying Component Services. ~—

9. Install OBI Publisher.

. . PURPOSE of this Physical
10. Start Insbridge Message Service. Environment

11. Login to RateManager and perform Insbridge database updates. This environment is for the

creation of rating programs.

12. Create Backup of Registry Key.

This environment also holds
the security information.

The installation must be run as Administrator.

IB_CLIENT
security

Attach to
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STEP 1. INSTALL INSBRIDGE ENTERPRISE RATING

1. Begin with the Oracle Insurance - Insbridge Enterprise Rating Install file. You must run as

administrator.

NOTE: The installation program requires that the installer have administrator rights on the machine

where the install is occurring.

FEn Application Toals Insbridge |_I_-_ g
“ Home Share View Manage v 9
© -t | » Win1100000 » Downloads b Insbridge v c:,| [ search Build 14 o]

¢ Favorites Mame Date modified Type Size
B Desktop H Oracle Insurance Insbridge Enterprise Rat... Open 174,964 KB
& Downloads = =
N [ Run as administrator
= Recent places = ——
Troubleshoot compatibility
1% Win1100000 Finto Start
4 Desktop Share with v
| Documents Bl Scanforthreats...
& Downloads Pin to Taskbar
i Music Restore previous versions
=] Picts
ctures Send to 3
B Videos
i, Local Disk (C:) e
Copy
€ Network
Create shortcut
Delete
Rename
Properties
Titem  1item selected 170 MB

Figure 7 Install as Administrator

NOTE: Please close all open applications before running the Oracle Insurance - Insbridge Enterprise

Rating file.
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2. Open the Oracle Insurance - Insbridge Enterprise Rating file. A Welcome screen is displayed.

13! Oracle Insurance - Insbridge Enterprise Rating Setup =10 -

4 Oracle Insurance Insbridge

[t i gtrongly recommended that vou exit all Windows programs before running this setup program.

Click Cancel to quit the setup program, then cloge any programs pou have running. Click Mest to
continue the installation,

WARMIMG: Thiz program is protected by coperight law and international treaties.

Ilnauthorized reproduction or distribution of thiz program, or any portion of it, may result in severe
civil and criminal penalties, and will be prozecuted to the maximum extent pozzible under law.

ORACLE
INSURANCE

| | Cancel

Figure 8 Installing Insbridge

3. Click Next to continue.
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13! Oracle Insurance - Insbridge Enterprise Rating Setup M
Destination Folder ORACLE

Select a folder where the application will be ingtalled.
PP INSURANCE

The Wize Installation \Wizard will inztall the files for Oracle Insurance - Insbridge
Enterprize R ating in the following folder.

Toinstall inta a different folder, click the Browse button, and select anather folder.

Y'ou can chooge not ta inztall Oracle Insurance - Insbridge Enterprise B ating by clicking
Cancel to exit the Wise Inzstallation Wizard.

D estination Faolder

C:A\Program FileshOraclet nzbridge',

“Wize Inztallation ‘Wizard [R]

<Back I Mext: | | Cancel

Figure 9 Entering the Destination Folder for Insbridge

Choose the location where the Insbridge installation will be installed. A default installation folder is

created for all new installs. This will be the location for all future installations for Insbridge

applications. Select Browse if you want to install in a different location. After selecting a location, click

Next to continue.
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13! Oracle Insurance - Insbridge Enterprise Rating Setup M

Logon Information GRACLE'

The following logorn information is uzed by Insbridge.
a7 il INSURANCE

Specify a uzer account to be used by the application, either for running a service or for
logaing onto other servers. Use the Browse buthon to choose uzers from pour network,.
For domainz, uger names must be in the format of DOMAIMAU serM ame.

Password: | eeeeseee |

| Create Mew Lser...

“Wize Inztallation Wizard®

< Back " Mest > | | Cancel

Figure 10 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen is displayed. You must specify a user account to be used by the application.
Please use the Insbridge user account that you set up on page 14.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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13! Oracle Insurance - Insbridge Enterprise Rating Setup M

Select Features GRACLE'

Pleaze zelect which features you would like to install.
d INSURANCE

Inzbridge Enterprize B ating

Feature Description:

: Oracle Insurance Insbridge Enterprize A ating iz
e a'w'eb-bazed rating, rules, and undenariting
systemn,

Thiz feature will be installed on the local hard
drive.

I hig featune requires UKE on your hard dive, |t
has 2 of 2 subfeatures selected. The
subfeatures require 3488KE on your hard drive.

“Wize Inztallation ‘Wizard [R]
| Dizk Cost | | Reset | | < Back " Mest > | | Cancel

Figure 11 Selecting Features for Installation

7. The next screen lists the applications to be installed. To expand the options and view details, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you
will be allowed to not install. Click Next to continue.

Options are:

e Insbridge Enterprise Rating:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

¢ RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
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Ready to Install the Application C}RACLE'
Click Mest to begin inztallation.
INSURANCE

Click the Back button to reenter the ingtallation infarmation or chck Cancel to exit
the wizard.

“Wize Inztallation ‘Wizard [R]

Cancel

Figure 12 Ready to Install

8. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the
options you want to install.

9. The installation displays the progress.
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3! Oracle Insurance - Insbridge Enterprise Rating Setup M

4 Oracle Insurance Insbridge

Oracle Insurance - Insbridge
Enterprise Rating has been
successfully installed.

Click. the Finizh buthon to exit thiz inztallation.

ORACLE
INSURANCE

< Back Cancel

Figure 13 Install Finish Screen

10. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2: CONFIGURING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
Insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
Assigning Permissions for the Registry Access

1. Right click the Start icon and select Run.

2. Type regedt32. Click OK. The Registry Editor will open.

1 Registry Editor (- [= ]
File Edit View Favorites Help
A--:l__i Computer MName Type Data
B | HKEY_CLASSES_ROOT ab] (Default) REG_SZ {value not set)

b 1) HKEY_CURRENT_USER
4. HKEY_LOCAL_MACHINE
b-J) BCDOODODOOD
b |, HARDWARE
bl SAM
L || SECURITY
4 || SOFTWARE

l> . Classes
l> . Clients
bl GNU
b
b

. Inshridge
Expand
MNew 3
Find...

Rename

I»

b -

I> i Delete
I»

I»

b Export

i) Permissions...

: Copy Key Name
[ L e =
b Wowb432Node
[~ L SYSTEM
b~ HKEY_USERS
[ - | HKEY_CURRENT_COMFIG

< m >

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Insbridge

Figure 14 Configure Registry Access Windows Server
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3. Browse to HKEY_LOCAL_ MACHINE. Select SOFTWARE->Insbridge.

4. Right click and select Permissions.
5. Scroll through the users. Select the Insbridge user.
6. Verify that the Insbridge user has Full Control.

7. If the Insbridge user does have Full Control, cancel out of the registry and continue with the
installation.

8. If the Insbridge user does not have Full Control, change permissions to allow for Full Control.
Save your entry and close out the registry. Continue with the installation.

9. If the Insbridge user is not listed, follow the step to add the Insbridge user.
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STEP 3. INSBRIDGE APPLICATION POOL

Insbridge requires .NET framework setting of v4.5.2 or v4.6.2 for Windows Server 2016. This may present
conflicts with other applications in the default application pool that require a different setting. To avoid
conflict and improve performance, a separate Insbridge Application Pool must be used.

Verify the Insbridge Application Pool

A default Insbridge Application Pool is created at installation. This pool ORACLE_FSGBU_INSBRIDGE
should be used for the Oracle applications. Please verify that the Insbridge web applications are

associated with the new Insbridge application pool.

1. Click Start > Administrative Tools - select IIS Manager.

} Internet Information Services (lIS) Manager
— =
@ |‘=} » Win1100000 » Application Pools
Eile  View Help
C i g_. . .
Q- | @ J Application Pools
€ Start Page This page lets you view and manage the list of application pools on the server. Application
”110900(_} pools are associated with worker processes, contain one or more applications, and provide
-4zt Application Pools isolation among different applications.
Il Sites
Filter: - Go - \gqShow All | Group by: _
Name * Status MET CLR V... Managed Pipel... |dentity Ap
[} NET V2.0 Started w20 Integrated ApplicationPoolld.. 0
[} NETv2.0 Classic  Started 2.0 Classic ApplicationPoolld.. 0
(£} NET w45 Started w40 Integrated ApplicationPoolld.. 0
[} NET w45 Classic  Started 4.0 Classic ApplicationPoolld.. 0
chassic.NETAp... Started w20 Classic ApplicationPoelld.. 0
2} DefaulthppPool  Started 4.0 Integrated ApplicationPoolld.. 1
22 0IDCAppPool Started w40 Integrated ApplicationPoolld.. 1
I {l-/ ORACLE FSGBU... Started  v4.0 Integrated Insbridge 3
< m >
< m > Features View Content View
Ready

£ Add Application Pool...

Set Application Pool Defaults...

&

2. Expand the Local Computer and select Application Pools. Verify the

ORACLE_FSGBU_INSBRIDGE application pool has a .NET CLR Version of v4.0, the Identity is
Insbridge and there are 3 applications associated. Changes can be made on the Advance Settings

page.

3. Select the ORACLE_FSGBU_INSBRIDGE application pool and right click. Select Advanced Settings.
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Advanced Settings |L-

fanaged Pipeline bMode Inteqrated ~
Marne ORACLE_FSGEU_INSERIDGE
Queue Length 1000 ]
Start Mode OnDernand

4 CPU
Lirnit {percent) ] =
Lirnit Action Modction
Lirnit Interval {minutes) 5
Processar &ffinity Enabled False L
Processor Affinity Mask 4294967295
Processor &ffinity Mask (B4-bit option) 4204067295

4 Process Model

[ Generate Process Model Event Log Entry

Identity Insbridge
ldle Tirme-out {minutes) 1]
Idle Tirme-out Action Terminate
I Load User Profile False |
Maximum YWorker Processes 1
Ping Enabled True hd

4. Verify the Load User Profile is set to falsel. Make any updates to the settings and save.

! For MS Windows 2012 R2 installations, you may receive an error when accessing IBFA for the first
time: The data protection operation was unsuccessful. This may have been caused by not having the
user profile for the current thread’s user context, which may be the case when the thread is
impersonating. In this case, the value of the Load User profile should be set to True.
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5. Expand Sites and select RM. Select Authentication in the 1IS section. Verify that Windows
Authentication is Disabled. Make any updates to the settings and save.

D » WinTIOO000 » Sites » Default'eb Site » RM »

File  Wiew  Help

Authentication

e--dlz |8 !
‘?2 i:fan:;;i;o Group by: Mo Grouping __~
@ application Pools Mame Status Respanse Type
‘@ Sites Anonyrmous Authentication Enabled
‘% Default Web Site ASP.NET Impersanation Disabled

| asphet_client Basic Authentication Disabled HTTP 401 Challenge
I -[2¥ DCP Digest Authentication Disabled HTTP 401 Challenge
b (¥ IBFA, Forms Suthentication Enabled HTTP 302 Login/Redirect
b [ inshridge | Windows Authentication Disabled HTTP 401 Challenge |
REXT

<| m [ T[> [= Features View |2 Cantent View

Configuration: 'Default ¥Web Site/Ri' web.config ‘ﬂ:g
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6. Expand Sites and select insbridge. Select Authentication in the IIS section. Verify that Anonymous
Authentication is Enabled. Make any updates to the settings and save. This setting allows users to

access online help. If users experience a 401.2 — Unauthorized message, check to make sure that
this setting is enabled.

Internet Information Services {15 Manager I;l_-

a
@ » Win1100000 » Sites » Default’Web Site » inshridge » |in @ -

®)

Im

ile  Wiew  Help

Connections

. Actions
I :@ Authentication @ Hep

&g Start Page

i G by i -
283 Win1100000 roup by Mo Grouping

15} Application Pools Mame - Status Response Type
& Sites | Anonymaus Authentication Enabled |
a &?} Default Web Site ASPMET Impersonation Disabled
b aspnet_client Basic Authentication Disabled HTTP 401 Challenge
b H DCP Digest Authentication Disabled HTTP 401 Challenge
b3 Forms Authentication Disabled HTTP 2302 Login/Redirect
Weindows Suthentication Enabled HTTP 401 Challenge
¢ m y . = Content View

Configuration: 'Default Web Sitefinsbridge web.config ia_:]

If the ORACLE_FSGBU_INSBRIDGE has not been created, you will have to create one. Please see
Appendix A, Creating an Application Pool.
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STEP 4: ASSIGNING PERMISSIONS: WINDOWS TEMP FOLDER

Permissions must be assigned for the Windows Temp Folder for MSMQ and for the application pool
default identity. Prior to assigning permissions, please verify the Insbridge application pool identity.

Assigning Permissions in the Windows Temp Directory:

1. Find the WINDOWS folder, most likely on your C drive.

2. Right click the Windows—>Temp folder.

I = Temp =1I5 -
“ Home Share View N 9
:(-:\ - 1 r Wi . Dt - v Temp » v ¢ | | Search Temp o ‘
- Expand
s
SchCache BraninEer s Date modified Type Size -~
b ). schemas )
» security Share with » 00005 File folder
b |l ServiceProfiles | U | Scan for threats... E':e?:(:er
ile folder
bl servicing Restore previous versions ;
o 00.log Text Document TKB
bl Setup Include in library 4 1 TedD . 1 KkB
dog ocumen
bl SoftwareDistribut i
' : :ra istribuf Pin to Start TMP File OKE
. ) S'mc Send to * leini Configuration sett... 1KE
un
b B Svet Cut SQM File TKE
. System
b Sy tem32 Copy ilebet Text Document 0KB
. System : o =
b SystemResources Delete File.tt Text Document OKB
B Sewowes o Configuration sett... 1KB
ename
T):PI Text Document 13KB
. Task Em ' Configuration sett... 2KB
. Tasks -
B = Properties Configuration sett... TKB
em
T pD % | MACAddress.ini Configuration sett... 4KB
oastData
K = | Netconfig_2015-05-11_1702log Text Document 5KB
¢ tracin
b v 9 | Netconfig_2015-03-11_2317 log Text Document 2KB
. Vs
, Web | NICValidation.log Text Document GKB
el
» WinSes | ProductMame.ini Configuration sett.., 3978 KB
. Win
| silconfiglog Text Document TKB
b wils12130 hd —_ e
21 items G =

Figure 15 Assigning Permissions for the Insbridge User on Windows Temp

3. Select Properties. The Temp Properties screen opens.
4. Select the Security tab.

5. Click Edit.

6. On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge
user is not found, cancel out and return to the Local Users and Groups area in Server Manager

and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.
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Security

Object name:  C:\Windows \Temp

Group or user Names:

2 CREATOR OWNER

52 5YSTEM

82, Administrators (Win1100000"Administrators)
H2, Users (Win1100000"sers)

2, 115_IUSRS (Win1100000I5_IUSRS)
& Insbridge (Win1100000%Insbridgs)

]

Pemissions for Insbridge

Full control

Modify

Read & execute
Ligt folder contents
Read

]I:II:IDDI:IE‘

Figure 16 Temp File Properties

8. Click OK to close the Permissions for Temp screen.

9. Click OK to close the Temp Properties screen.
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STEP 5. ASSIGNING PERMISSIONS: INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location.

1. Locate the Insbridge installation directory. If you selected another directory when installing the
Insbridge application, go to that directory. The default installation directory is located at:
C:\Program Files\Oracle\Insbridge.

2. Right click the Insbridge folder.

N Insbridge - |= =0
“ Home Share View 0
:(-:\ - 1“ » Win1100000 » Local Disk (C:) » Program Files » Oracle » Insbridge » v Cf| | Search Inshridge i ‘
s
AboutTime ~ Name Date modified Type Size
b J. Common Files )
. COM+ File folder
b L. Internet Explorer )
. Framework File folder
bl Java
SDK File folder
b | MSBuild )
. SoftRater File folder
. MetConfig )
. Webs File folder
4 . Oracle
13 Insbridge
Expand
3 Insurance
b Inventory Open in new window

b . Reference Assemblies| @ Scan for threats...
¥ i System Configuration Restore previous versions
P s UltraVNC Include in library 3
. Windows Mail Bin to Start
3 Windows NT
b}l WindowsPowerShell sendto '
b . Program Files (x86) Cut
. Temp Copy
3 Users Delete
b Windows Rename
. bl wils12130 — N
5 items
T

. Profile Copier

Share with

Figure 17 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties. The Insbridge Properties screen is displayed.

4. Select the Security tab.

5. Verify that the Insbridge user created earlier is assigned to the directory and has Full Control. If
the Insbridge user is listed and has Full Control, proceed to the next step.
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| General I Sharing | Security | Previous Versions | Customize

Object name:  C:\Program Files"Oracle’nsbridge

Group or user Names:

2 CREATOR OWNER
52 5YSTEM
b ¥ insbridge (Win110000\Insbridge)

imoston ANintOGlA0 Mnnitton

To change pemissions, click Edit.

Pemissions for Insbridge

Full control

Modify

Read & execute
Ligt folder contents
Read

White

For special permissions or advanced settings,
click Advanced.

Figure 18 Insbridge Folder Properties

6. If the Insbridge user is not listed, click Edit. On the Permissions for Insbridge screen, select the
Insbridge user and click Add. If the Insbridge user is not found, cancel out and return to the Local
Users and Groups area in Server Manager and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.

8. Click OK to close the Permissions for Insbridge screen.

9. Click OK to close the Temp Properties screen.
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STEP 6. RESTORING INSBRIDGE DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latin1_General CP1_CI_AS and sort
order plus case sensitivity using Latin1_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

SQL Server
2012
RateManager — IBRM
Latinl_General_BIN
DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
SQL_Latinl_General_CP1_CI_AS
DATABASE_BACKUP_IBRM_TEMPLATE.bak
Security — IB_CLIENT
SQL_Latinl_General_CP1_CI_AS
DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
2016
RateManager — IBRM
Latinl_General_BIN
DATABASE_BACKUP_IBRM_TEMPLATE.bak
SQL_Latinl_General_CP1_CI_AS
DATABASE_BACKUP_IBRM_TEMPLATE.bak
Security — IB_CLIENT
SQL_Latinl_General_CP1_CI_AS
DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive for the
SQL Server instance you are using. The Security: IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “ TEMPLATE” from the name. You can change the
names after they have been restored also.
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Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE:

If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.

6. Go to Databases.

£ Microsoft SQL Server Management Studio (Administrator) = | -
File Edit View Debug Tools Window Help

P - S @ | L Newouey [y E T[4 @]9 -0 -E-5 4] | | -
Object Explorer

Connect~ 33 % m F (2] .5
= [ SQL2100000ASCL Server

* "‘I - MNew Database...
m [ Se

= [ Se Attach...

® O Re Restore Database...
w L M

Restore Files and Filegroups...

Deploy Data-tier Application...
Import Data-tier Application...

Start PowerShell

Reports 3

Refresh

Figure 19 Right Click to Restore Database

7. Right click on Databases.

8. Select Restore Database... A separate screen is displayed.
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i Restore Database - IB_CLIENT_A| =1 1= -
@ Ready
Select a page SScript - mHelp
24 General
f Files Source
2 Options
() Database:
® Device: |C:\Program Files\Microsoft SOL Server\MSSQL | El
Database: | |IB_CLIENT_TEMPLATE v |
Destination
Database: |IB_CLIENT_AI v]
Restore to: |The|ast backup taken (Thursday, April 23, 201512:54:13AI|
Restore plan
Backup sets to restore:
Restore MName Componert Type  Server Databasze Posttion  First LSM Last |
: ' Database Full  SLCO2IWB IB_CLIENT_TEMPLATE 1 649000000037500229 6490
Connection
2{ SQL2100000MSOL Server
[Insbridge]
View connection properties
Progress
< m >
' Daone
'@ Verify Backup Media
QK | ‘ Cancel | ‘ Help ‘

Figure 20 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:.

10. Select From Device. Click ... to browse to the location where the database files were placed in
step 3.

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step 4.
12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.

14. Click OK.

15. If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

16. Repeat for the RateManager database and any SoftRater database.
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17. Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see The initial installation of
Insbridge uses the default language of the server where Insbridge is being installed.
For example, if the default language is EN-US, then Insbridge will use that setting. If
the default language is updated but RateManager is not reflecting the change, please
verify that the .NET Globalization setting on the Insbridge, RM, and IBFA sites in IIS
have been updated.
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Database User Roles and Permissions for more details), then the ibru SQL server user
account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.
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STEP 7: CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser and browse to the following location, replacing SERVERNAME
with the actual server name:

http://SERVERNAME/IBFA

Do not use Localhost.

Logging in to IBFA
The default security setting for a new installation is Custom and requires a login to access.

L 3 (E0)| © nttp:/win1100000/1BFA/ 0 - ¢ | & Framework Administrator (.. |

Version 05.06.00 (x64)

@ Show FrameworkAdmin Menu

Explorer not configured. Please contact your system administrator.

Click “Show Framework Admin Menu” to display login options.

Figure 21 IBFA Landing Page

1. IBFA requires a login to access. Click the Show FrameworkAdmin Menu link to display the login.
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- O -
Q@)[ @ http://win1100000/BFA pL~C |] @ Framework Administrator (... | ‘ A Kk T
ORACLE. Insurance Insbridge Framework Administrator Version 05.06.00 (x64)

x| Explorer not configured. Please contact your system administrator.
& Access Secure Services
User ID:

Log On

Copyright © 2000,2009, Oradle and/or its affiliates. All rights reserved.

Figure 22 IBFA Login Screen

2. Enter the default User ID and password:

User ID: admin
Password: insbridge

3. The IBFA home page is displayed.

Troubleshooting

For MS Windows 2012 R2 installations, you may receive an error when accessing IBFA for the first time:

The data protection operation was unsuccessful. This may have been caused by not having the
user profile for the current thread’s user context, which may be the case when the thread is
impersonating.

If this error is presented, locate the Insbridge Application Pool on the server where Insbridge was

installed. Administrative Tools>11S Manager->ORACLE_FSGBU_INSBRIDGE, right click, and select
Advanced Settings. Change the Load User profile to True.
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Updating IBFA Security

4. Itis recommended that you change the login password immediately. You do not have to change
the password.

5. On the left side menu, select Security->Change Password.

Change 'Custom Security’ Admin Password
Insbridge suggests that you use a password that is 6-8 characters long. If you think someone else knows the admin

=3 Insbridge

w-C1 SoftRater password, please contact your system administrator.,
- 1 SoftData

-l Services
#-_J Logs Old Password
El"" Security New Password

g:; SoftLibraries Confirm Password

- @) Help

Update

Figure 23 Updating the Default Password

6. Enter in the default password for the old password and enter in the new password of your choice.
Confirm the new password and click Update. A success message is displayed when the admin
password is updated. If an error message is displayed, make corrections and try again.

7. If you do not want to require a login, you can change the security to None. This changes the
default landing page to the IBFA home page and removes any login requirements.

Framework Administration Web Security

E-L3 Insbridge To utilize Windows authentication please select the Windows security option and contact your system administrator to

#-[J SoftRater update your IIS settings. The Insbridge Custom Forms authentication requires that you enter an admin user and
= password combination for web access.
-] SoftData
- Services
#- 4 Logs
=B @ HrTP
“~[_] Change Password ) HTTPS
{8 SoftLibraries
@) Help
(® None
() Windows
() Custom

Allow unauthorized users to view secure environments? (read-only)

Figure 24 Selecting Security for IBFA

8. On the left side menu, select Security.
9. Select the protocol you want to use, HTTP or HTTPS.
10. Select the authentication. For example, if you select HTTP protocol and None for authentication,

no security is applied. The IBFA landing page will be updated to the IBFA home page and no
login will be required.
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NOTE: For other security options, please see the IBFA user guide for more information on setting up
Windows security.

Entering Company Information

Prior to users entering RateManager, the Insbridge Framework Administrator must be configured for your
company.

Be |
P~-C || '{‘5” Framework Administrator (.. ﬁ " A

G@[ @ http:/win1100000/BFA

ORACLE nsurance f A Version 05.06.00 (x64)
x|
E i}conﬁguration File [C:\PROGRAM FILES\ORACLE\INSBRIDGE\FRAMEWORK\4.5.0\Insbridge.Xml]

The Framework Administrator Web will configure any Insbridge F k Confi ion file (Insbridge.xml) found on
your network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all

-3 SoftRater

[ SoftData
3 Sservices
Logs

Security
-~ Change Password

apps that reside on the same Framework Server share the same file.

Change Config File location: C:\PROGRAM FILES\ORACLE\INSBRIDGE\FRAMEWORK\4.5.0\I | Edit || Apply

Click on "Edit" button to enable the text box above. Copy and paste the new Insbridge XML file location in the text box.
Then dick on "Apply” button to apply the new configuration file.

Add Subscriber
€ subscriDer iaentifier is an unique number that you would like to represent your company. Please consult with an

Insbridge support representative if you have any questions.

@ No Subscribers found.

Add Database Connection

Create or edit database connection. This database connection can be global to the Insbridge Framework or unique to the
Subscriber.

Click on the name of the connection to edit.
£ Global

@ No Connections found.

Copyright © 2000,2009, Oracle and/or its affiliates. All rights reserved.

Figure 25 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

There are five steps that need to be done in IBFA:

e Step 1: Creating a New Subscriber
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e Step 2: Adding a Global Database Connection
e Step 3: Adding a Security Database Connection
e Step 4: Adding an RM security Database Connection

e Step 5: Creating a RateManager Environment

Step 1: Creating a Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

1. Click on Add Subscriber on the Main IBFA screen. A separate screen is displayed.
2. Enter the ID, Name and Description for your subscriber.

3.  When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

2l Subscriber -- Webpage Dialog -
Subscriber

Please enterfupdate your Inshridge Customer information below.

1D: 8659

Mame: Alamere

Desc: Alamere Insumncd ®

Save Cancel

Figure 26 Enter ID

NOTE: Make note of the subscriber ID nhumber. You may need to enter this on another IBFA or IBSS
environment.
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The Subscriber ID can be a 1-5 digit number and must unique for each subscriber. For example,
if you have an instance of IBFA on machine A, you can create a subscriber with an ID of 100. On
machine A, if you create another subscriber, you must give that subscriber a different ID number,
say 200. If you also have an instance of IBFA on a different machine, B for example, you should

duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.

NOTE: If your entries are not saved, verify that you are using a valid URL with an IP address or DNS
name. Do not use localhost.

Next Step: Add Database Connections:

- O -
e@!é} http://win1100000/IBFA/default.aspx/servername P~ ” & Framework Administrator (... | n Y,’k &}
ORACL_E. Insurance Insbridge Framework Administrator Version 05.06.00 (x64)

-
= £ P
: SoftRater §_§Conﬁ uration File [C:\PROGRAM FILES\ORACLE\INSBRIDGE\FRAMEWORK\4.5.0\Insbridge.Xml

The Framework Administrator Web will configure any Insbridge Framework Configuration file (Insbridge.xmi) found on your
network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
that reside on the same Framework Server share the same file.

SoftData

Change Config File location: F B E\FF Edit| | Apply

Click on "Edit” button to enable the text box above. Copy and paste the new Insbridge XML file location in the text box.
Then dick on "Apply” butten to apply the new configuration file.

Add Subscriber
The subscriber identifier is an unique number that you would like to represent your company. Please consult with an
Insbridge support representative if you have any questions.

# 8659 - alamere - Alamere Insurance

| Add Database Connection |

Create or edit database connection. This database connection can be global to the Insbridge Framework or unique to the
Subscriber.

Click on the n
€2 Global

# No Connections found.

Copyright © 2000,2009, Oradle andjor its affiiates. All rights reserved.

Figure 27 Adding Database Connections

Stay on the Main IBFA screen. Three databases must be added to IBFA:

e Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the Insbridge system. This is not unique to the subscriber.

e Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
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database and is required for subscriber security information.

e Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

To continue, you will need to exact names of the databases you restored in Step 6, IBRM_xxxx, and
IB_CLIENT databases.
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Step 2: Adding a Global Database Connection:

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.

1. From the Insbridge page, click the Add Database Connection link. This opens the Connection
screen.

2l Connection -- Webpage Dialog -

Connection
Database connections can be global to the Insbridge Framewark or unigue to the Subscriber.

Subscriber: |Gl|:|-bal v
Mame: Controller
Server: 10.100.10.100 Test Connection...

Server Type: ISQLSer‘.rer ﬂ

Catalog: IB_CLIENT

Catalog Type: |Dther v

Query Buffer:

Tablespace:

Schema:

UUser: 5d

Password: TIITIIL -

Save Cancel

Figure 28 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases are all SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 6.
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7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm

databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as

database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller

database will be listed.

Step 3: Adding a Security Database Connection:

1. Next, add the security database. Select the Add Database Connection link again.

2. Select Your Subscriber. The security database is unique to the subscriber.

3

Connection -- Webpage Dialog

Connection

Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: |.ﬁla mere Insurance v
Name: Security
Server: 10.100..10.100 Test Connection...
Server Type: ISQLSer‘.rer ﬂ
Catalog: IB_CLIENT
Catalog Type: |Dther v
Query Buffer:
Tablespace:
Schema:
User: &d
Password: T -
Save Cancel

Figure 29 Setting up the Security Database Connection
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3. Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 6.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller

database will be listed

Step 4: Adding an rm Database Connection:

1. Next, add the rm database. Select the Add Database Connection link again.
2. Select Your Subscriber. The rm database is unique to the subscriber.
3. Enter rm for the Database Name. This cannot be changed once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 6.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

Oracle Insurance Insbridge Enterprise Rating Installation Guide Page 57



Chapter 3 — Full RateManager Installation

21 Connection -- Webpage Dialog -

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: |.ﬁlamere Insurance ﬂ
Name: RM
Server: 10.100.10.100 Test Connechion...

Server Type: ISQLSer‘.rer ﬂ
Catalog: IBRM

Catalog Type: |Ratel‘-‘|anager ﬂ

Query Buffer:

Tablespace:

Schema:

User: &d

Password: T -

Save Cancel

Figure 30 Setting up the RateManager Database Connection

NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Logical Environments:

Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:
e RM: to handle rating and testing.

You can create additional environments at this time if necessary or you can add them in at a later time.
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Step 5: Creating a RateManager Environment:

It is recommended that only one RateManager environment be created.

1. Browse to SoftRater>Explorer->Subscriber name.

LD ED)| & http://win1100000/1BFA/default.aspx

P~-c eFrameworkAdministrator (. X #fr ok X

ORACLE. Insurance Insbridge Framework Administrator

—

-1 SoftData
- Services
-3 Logs

sey Softlibraries
..... @) He

< I >

Confi

Version 05.06.00 (x64)

Environments

nvil it
A or remove environments from your Explorer configuration.

AME - DESCRIPTION

# No environments found.

Product Management
Your rating book of businesses are identified by an id and a description. There is no limit to the number of Product’s (ine-of-
business) that your Explorer can contain.

D - DESCRIPTION

# No Products found.

Virtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server.

D RIPTION - SERVER - TYPE - ENVIRONMENT

# No file servers found.

Figure 31 Create a Rating Environment

2. Click on Add Environment.
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=

SoftRater

A SoftRater configuration can support an unlimited number of environments.

MName: RM

Type: IDE\I'

Secure: |:|

Figure 32 Entering Name and Environment

Enter a Name and select a Type. The nhame and type are totally dependent on how your
Insbridge system is designed.

There are three types of Logical Environments:

e Development

e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORACL_E msurance Insbridge Framework Administrator

Add Environment

Add, edit, or remove environments from your Explorer configuration.

MAME - DESCRIPTION

# BM - Development
# A - Quality Assurance
# Prod - Production

Figure 33 Obtaining Environment Information
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1. Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

- O -
e & http://win1100000/|BFA/default.aspx L~-C ” & Framework Administrator (... | | ok 1
) - = I ¢
. .
ORACLG Insurance Insbridge Framework Administrator Version 05.06.00 (x64)
= |
Content Settis
=4 Insbridge L} ngs
SoftRater ‘
i~ Engine
B8 Explorer Configuration A
Eavironments Environment(s) you may use for development purposes. Selecting an environment below will denote it as the default.
-1 SoftData
- Services Environment: RM ®
- Logs Test Environment...
B[ Security DB Server: 10.100.10.100
o e
se Softlibraries DB ServerType: sQLServer v
Q) Help DB Catalog: IBRM_AT
DB CatalogType: RateManager v
DB Query Buffer:
DB Tablespace:
DB Schema:
DB User: sa
DB Password: ssssssee
Engine Type: Windows N
Engine Location: LOCALHOST [T Location is a Cluster
Engine EnvDef: Discover
Qi
Environment(s) you may use for quality assurance purposes. Selecting an environment below wil denote it as the default.
Environment: QA
Package Location: C:\Insbridge\Packages\QA Test Environment...
DB Server: 10.100.10.100
DB ServerType: SQLServer N v
DB Catalon: IBSR_ATL
< > Copyright © 2000,2009, Orade and/or its affiliates. All rights reserved.

Figure 34 Editing Environment

2. The Environment Name will be complete. No changes are needed.
3. RateManager environments will not have a Package Location. No entry will be allowed.

4. Enter in the DBServer name or IP address. This is the database server where the RateManager
database was restored. For DB2 servers, this is the DB2 Registered Alias Name. For Oracle
servers, this is the server name; either IP or DNS will work. The default port used is 1521. The
Database listener port number can be appended to the server name if it is something other than
the default port. The format for this is: [SERVER NAME]:[PORT NUMBER]

NOTE: If a specific instance of SQL Server is required, for example if a shared MS SQL Server is being
utilized, the format for this is: [SERVER NAME\INSTANCE NAME]:[PORT NUMBER]

5. The DB Server Type will be SQL Server.

6. The DB Catalog is the name of the RateManager database restored in SQL Server.
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10.

11.

12.

13.

The DB Catalog Type is RateManager.

DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.

Enter the DB User name and Password.
The Engine Type is Windows.

The Engine Location default is LOCALHOST. Most RateManager installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManager installations do not require an
entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Follow the same procedure of restoring the database, then entering in IBFA.

Optional Setting: Threads

If you know the number of Web Rate Threads you need, you can enter this information now. If you do not
know, you can enter this information later. For more information on threads, please see the IBFA User

Guide.

WARNING: Before changing the number of threads, you should consult with your system

administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Insbridge recommends a maximum of 2 threads.

There are multiple thread settings in the Insbridge system:

Batch Packing Thread: Found on the Preferences screen of RateManager. This setting is the
maximum number of threads to be used for RateManager Batch Packaging. Batch packaging is
building of packages inside RateManager. This thread setting will not affect rating or any other
process in IBFA.

IBFA Web Rate Threads: Found on the SoftRater Engine page in IBFA. This setting is the
maximum number of threads to be used for rating that is sent through the SoftRater web services.
If you want responses to be returned in the order submitted, this thread setting must be higher
than the maximum number of rate requests contained within a single XML request.

IBFA Message Services Threads: Found on the Message Services page in IBFA. Individual
thread usage can be set for Batch Rating, Batch Scenario and SoftRater-Package.
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e Packaging (Table Variable) Threads: Found on the SoftRater Engine page in IBFA. This setting
is the maximum number of threads to be used when packaging table data. If you want responses
to be returned in the order submitted this thread setting must be higher than the maximum
number of rate requests contained within a single XML request.

STEP 8. VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.
1. Click Start>Server Manager>Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

o

Component Services = = -

%. File Action View Window Help
= #E XE G HE T
[Z Conscle Root - = = Actions
4 % Component Services =1} ] == . .
e Insbridge Com+ Administrat..
4 [ | Computers Components  Legacy Roles -
a (& My Computer Companents More Actions

a4 [ | COM+ Applications
~€:i-.'|} COM+ Explorer
£ COM=+ QC Dead Letter Queue Listener
oM~ Utilities
@ COb Ltilities (32 bit)
g- Insbridge Com+ Administrator 4.5
g Insbridge Com+ SoftRater Engine
2 Insbridge Com+ SoftRater Library
System Application

[ [ DCOM Cenfig

- || Running Processes

- || Distributed Transaction Coordinator
b @ Event Viewer (Local)
I+ 05 Services (Local)

-

-

v v v F v v v |

Figure 35 Component Services

There should be 3 Insbridge Com+ Applications libraries:
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e Insbridge Com+ Administrator 4.5
e Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

NOTE: If any COM+ library is missing, run the Insbridge install again from the msi file and choose
uninstall. Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see
if all the libraries are listed. If they are still not listed, please log a Service Request with Support.

Verify the Identity of the Com+ Applications Libraries

Please note that you should not have to make any changes to any COM+ Application library. The
installation will automatically apply the Insbridge user name and password that you created earlier to the
necessary libraries.

1. Select the Insbridge Com+ Administrator 4.5.

2. Right click and select Properties.

3. Select the Identity tab.

4. Verify that the User is Insbridge. If the user is System Account or is not set to the Insbridge user,
change to the Insbridge user set up earlier.
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Advanced I Dump | Pooling & Recycling
General I Security | Idertity | Activation I Clueuing

This application will run under the following account.
Account
() System Account:

(! Interactive user - The cument logged on user
() Local Service - Builtin service account.
() Metwork Service - Builtin service account with network access

() Local Sﬁstem - Complete access to local machine

| Inshridge

Password: ||||-|||-||-|||- |

Confirm password: ||||-|||-||-|||- |

@ Server applications cannot run under system service accounts.

Leam more about setting these properties.

Figure 36 Updating Com Plus to the Insbridge User

5. Repeat for the other com+ services.
6. On the Insbridge Com + SoftRater Engine Properties, check the “Leave running when idle”

option. This option allows cache to hold for loading. This setting is necessary for Windows
SoftRater with cache enabled.
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| General | Secuity | Identiy
Advanced | Dump

Server Process Shutdown

(®) Leave running when idle

i) Enable idle shutdewn: Minutes; |3

Protection
[] Disable deletion
[ | Disable changes

Debugging
[ ] Launch in debugger

Cebugger path: C:\Windows'\s{,rstem.?r?\dllhnst| | Browse.

[ | Enable compensating resource managers

[ ] Enable 35E support

Leam maore about setting these properties.

Figure 37 Enabling Idle Shutdown
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STEP 9: INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

1. Unzip the OBI_PUBLISHER

%, OBI Publisher Setup Setup = = -

OBl Publisher -
Release Motes, (

elegse to 10.1.3.4.0/

Install | | Cancel

Figure 38 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Server Manager in
Windows Server.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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OBI Security

The OBI Publisher requires a default User ID and password to be entered in IBFA. OBI is required to
create certain reports in RateManager. Users will receive error messages if the OBI Publisher Credentials

are not completed.

ORACL_E msurmance Insbridge Framework Administrator

[x]
E-C3 Insbridge Configuration File [C:\PROGRAM FILES\ORACLE\INSBERIDGE\Webs\IBFA\Systems\SoftRater\Xml\rnx.oml

Plzasze enter the SoftRater Explorer configuration information below.

EI|_:I SoftRater

Admin Email Address:
""" 1 Alamere Insurance
-1 SoftData
- Services
- Logs =
E-C3 Security Internet Proxy: :: None
I_J Change Password h UserlD Password
-8 Softlibraries
@) Help
Intranet Credentials: (®) Use Anonymous
() Domain UserlD Password
OBI Publisher Credentials: UserlD Administrator Password resessessnene|

Sawve

Figure 39 OBI Publisher Credentials

1. On the left side menu, select SoftRater-> Explorer.
2. Locate the OBI Publisher Credentials.
3. Enter the default user name and password.

User ID: Administrator
Password: Administrator

4. Click Save to save your entry. You must click Save prior to exiting the page.
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Updating OBI Publisher Password

You can immediately update the OBI Publisher password if you want. The password must be updated in
OBI Publisher and then in IBFA.

1. Enter the OBI Publisher console. http://servername:9704/xmlpserver where SERVERNAME is
the machine where IBFA/RM is installed.

2. Select the Admin tab.
3. Under Security Center, select Users.

4. Select the administrator Username.

TOIRACLE' Bl Publisher Enterprise

Welcome, administrator Preferences Sign Out Help

Reports | Schedules | Admin

[ Admin > Users > Update User: administrator |

Update User: inistrator

Cancel I Apply

Username administrator

Figure 40 Updating the OBI Publisher Password

5. Enterin a new password and click Apply. This updates the Administrators password.
6. Sign out of OBI Publisher.
7. Enter IBFA.

8. Open the SoftRater Explorer Configuration window. Enter the same password in the OBI
Publisher Credentials.

9. Click Save. The password has been updated.

NOTE: A login screen is displayed on IBFA for new installs. An upgrade will not reset the current security
setting. For example, if a login was not required for IBFA, upgrading to release 05.06.xx will not
change that. Please see the Insbridge Upgrade Guide for more information.
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STEP 10: STARTING INSBRIDGE SERVICES

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task Manager is
a task queue that lists the tasks that are scheduled to be performed as well as the last time the task was
run and the status.

Insbridge Message Service

The Insbridge Message Service is @ Message Queue Listener that will route all batched messages to an assembly (process)
for execution, These processes may take resources and time to execute, Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating W | | View Messages | | Edit Process Configuration |

If vou =ee this mes=age, yvou have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out messages that are waiting to
execute.

Insbridge Task Manager

The Insbridge Task Manager gives you the ability to execute daily, weekly, hourly, or by the minute,

(This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 41 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.
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STEP 11: PERFORMING UPDATES IN RATEMANAGER

There are two updates that should be done in RateManager prior to creating user groups and users:
e Step 1: Running Database Updates

e Step 2: Updating Preferences

Entering RateManager:

The URL for RateManager will be http:/SERVERNAME/RM. Where the SERVERNAME is the server
where RateManager was installed.

This places you on the RateManager login screen.

1. To login for the first time, select your company from the drop down menu. If you have created
only one company, a drop down menu will not be presented.

2. The user name is demo.
3. The password is password.
After running database updates, it is recommended that you update the demo user password.

Users and User Groups can be created after any database updates are run. For more on user
management, please see the RateManager Tools User Guide.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in IBFA.
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Step 1: Running Database Updates

If you log into RateManager and Tools is the only option, you must perform a database update. After you
perform the database updates, to view all menu options, click File>Reload.

e =) http://localhost/RM/Main/MainPage.aspx?page=default ~ & || Search... O~

@ Oracle Insurance Insbridge ...

ORACI—E Insurance InSbridge RateManager Version: 05.06.00 Subscriber: alamere User: Company Administrator

File  Tools  Help

g
x

Home

[/ DB Update =

o Please run the update scripts on the database.

Figure 42 Tool Mandatory Update

NOTE: If you log into RateManager and Tools is the only option, you must perform a database update.

On the DB Updates screen, the current version will be highlighted and the status will be Current. The
updates below the current version will be grayed out. These updates cannot be run again. Current
updates can be re-run if necessary. You will receive an error message if you attempt to run a lower
version update. Any version update above the current version will also be grayed out but will be available
for executing.

New installations may show 05.06.00 as current but still have only the Tools option available. You may
have to run the current script again. To see if you have complete access, click File->Reload to refresh the
system.

Navigate to the Tools—>Database—>Updates.

1. The Updates tab is displayed. Select the database you want to view from the Show updates for
drop down. The database updates for your selection is listed. The last column, the Status
column, shows you which update is the Current one installed.
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ORACLE’ Insurance Insbridge RateManager
File  Tools Help
" Home 1 DB Updates x

(33 DB Updates

LE Execute Update Script ,[.B Open Update Script B Save Update Script to File @} Refresh

Show updates f'or:l IBRM v

Script Release Date Database Status

v05.06.00.00 12/1/2017 IBRM

v05.05.00.00 6/1/2017 IBRM
r05.04.00.00 12/31/2016 IBRM
v05.03.00.00 IBRM
v05.02.00.00 IBRM
IBRM
BRM
11/1/2014 BRM
v04.08.00.00 4/1/2014 IBRM

Figure 43 Available Updates

2. There are two ways to execute an update:
a. Directly in RateManager
b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This assures that the database showing as Current will have all possible updates.

1. Highlight the update you want to run.

2. Click EXECUTE UPDATE SCRIPT. A warning message is displayed.

3. Click OK to run the update or Cancel to return to the previous screen.

4. Run all script in consecutive order until the 05.06.00 script is showing as current.

5. Do this for IBRM, and IB_CLIENT.

6. After updating IBRM and IB_CLIENT, update Reporting. The Reporting script must be run last.

7. Click File>Reload to refresh the system.
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2| Confirm Update -- Webpage Dialog -

™ Are you sure you want to replace the
!—/l current database’s contents with the
selected release script on disk?
2 Ok | & cancel |

Figure 44 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Database names can be found in IBFA->environments. Please see Manual Updates to the Insbridge
Database.
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Step 2: Updating Preferences

Administrators can edit system settings at any time from the Preferences option in RateManager.
Changes take place after the user sessions have been ended. If web settings are changed while the
users are inside the module, the changes will not be visible to them. Prior to users accessing
RateManager for the first time, it is recommended that Preferences be set.

Changing System Settings

1. Select Tools>Preferences. This opens the Preferences window.

2. Select System. This option is displayed only if you are an administrator.

e B

‘ Preferences

= Settings A
-User .
T ¢ System Settings
i Home Fage yst 9
- Administrator
L. gystem Inshridge Configuration File Path: [C:\PROGRAM FILES\CRACLE\INSERIDGE|FRAMEW CRK\4.5.0\]
) Impact Analysis Messaging
~-Migrate Workfiles| sarver: I.NETﬂ |Ic-c,a|host | (Sacure Channal) |:|
SoftRater Sarver I.NETﬂ ||Dca|hc-st | (Secure Channel) D
Tzble Management Messaging
Server (JAVA Onky): | | | Test ... | (Secure Channel) D
‘WorkFiles Share Folder Location: | |
DB Backup Share Folder | |
Location:
Tzble Management Export
Include Asterisk for Blank Calls: True ﬂ
Tzble Management Import Excel
Praview Rows: 5 ﬂ
Use Insbridge Com+ Admin: ITrue ﬂ
Enforce Relezse Packaging: IFalseﬂ
Batch Package Threads: El
Minimum Login User I Length:
User must change password: (Days)
Show Owerride Dats Mask: True ﬂ
Allow Datz Type Change: ITrue ﬂ v
Inactive Session Time Out: E[hrﬁ)

o  Save | @ Close |

Figure 45 Preferences Settings

3. Make any necessary changes.

4. When you are finished, click Save to update your settings. If you want to changes to take place
immediately, you may have to end all user sessions.
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System Setting Options
Insbridge Configuration File Path

The path of the configuration file found in IBFA. This pathway must match the IBFA path. You may need
to change this path if you have changed the path in IBFA. Please contact Insbridge support for further
information.

It is strongly recommended that you leave the default.

Impact Analysis Messaging Server

Impact Analysis is set up to run on the same server where RateManager is located. The Impact Analysis
Messaging Server setting allows for select SoftRater instances to be used when running scenarios
through Impact Analysis. Only an Insbridge SoftRater Server (IBSS) utilizing an Oracle database can be
entered. When an IBSS instance utilizing an Oracle database is entered, the environments on the IBSS
instance will populate Impact Analysis and Impact Analysis will query against the Oracle database. If an
IBSS utilizing another database type is entered, no environments will be populated.

To use and IBSS instance with an Oracle database, select the server type Java (For SoftRater for
WebLogic, WebSphere or JBoss) and enter the IBSS URL.

If localhost is used, Impact Analysis runs queries against the disk where batch files are stored. The server
type must remain .NET. The default value is to remain on the RateManager server.

Check Secure Channel if HTTPS is to be used.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Check Secure Channel if HTTPS is to be used.

Table Management Messaging Server (JAVA ONLY):

Table exports require a Java instance. If you want to use the Table Management feature, you must enter
an Insbridge Java server location. Format requires the port number being used but does not require
preceding slashes. DNSname:port or IPAddress:port For example, if you wanted to use a WebLogic
IBSS instance the format would be: 10.100.10.100:7001.

If you do not enter a valid Insbridge Java server location, table exports will not work.
The testing option tests the table data import/export setup. Connections to the application server, the

database and the shared workfiles location are all tested to make sure valid connections and permissions
are in place.
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Work Files Share Folder Location

A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles.
The Insbridge server and the shared location must be on the same domain. The Insbridge user must be
on the domain also.

For instructions on setting up a WorkFiles Share Location, please see the Insbridge WorkFiles Installation
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html

DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, use a local path. If the location is not local, you must be a disk admin to change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must

have write access to this location as well.

Table Management Export Include Asterisk for Wildcard

When the Table Management Export Include Asterisk for Wildcard option is set to True, an asterisk is
inserted for wildcard null values. This is automatic in tab-delimited exports. For Excel exports, the option
is activated but can be overridden.

Table Management Import Excel Preview Rows

Select the number of rows available for preview when importing table data from MS Excel. Available in
increments of 5, 10 or 20 rows.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.
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Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True allows RateManager users change the data type of a variable or input. Setting
this option to False does not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.
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Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting places a
carriage return between result files. A False setting results in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.

Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it is mandatory for users to enter a change control entry and justification to any
element or program when it is revisioned. If change control is off, the option is not presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
allow users to have opened in RateManager. The default is 15.

Debug Report Format

Select the debug report format to be used in the Test Program section of RateManager. Debug reports
can be a single report format, where the entire report is listed out or in a summary report format where
information is contained in sections that can be expanded and collapsed. Summary report format may be
useful if large programs are to be run. This setting can be updated at a later time.
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Default Naming Standard

Select the Naming Standard to be applied system. If a Naming Standard is not needed system wide, clear
the field. The default is for the system default to be used. Please see Naming Standards for more
information.

Enable Worksheet for Test Case Editor

Select true to have the option to create a rating or calculations worksheets in Test Case Editor. Select
false and the option to create a worksheet in Test Case Editor is not presented. Please see Worksheets
for more information.

Virtual File Server

The virtual file server requires an entry if HTTP or HTTPS is set in IBFA to provide the DNS name (ex:
server.us.example.com) of the deployed environment. The default is local host. Check secure channel if
HTTPS is to be used.

Reporting Threads

Enter the number of threads to be used for reporting. The field is initially blank and the system will default
to a single thread. Entering a value higher than the default may result in better system performance.
Reports may run faster as you approach an optimal thread count. The thread count is based on the
hardware capabilities (number of CPU cores and memory) of the server. A high thread number does not
necessarily warrant a faster performance. You should analyze how much data you need to process and
the capabilities of your server to get to an optimal number. A value does not have to be set.

Global Versions Report Threads

Enter the number of threads to be used for global version reports. The field is initially blank and the
system will default to a single thread. Entering a value higher than the default may result in better system
performance. Reports may run faster as you approach an optimal thread count. The thread count is
based on the hardware capabilities (number of CPU cores and memory) of the server. A high thread
number does not necessarily warrant a faster performance. You should analyze how much data you need
to process and the capabilities of your server to get to an optimal number. A value does not have to be
set.

STEP 12: EXPORT INSBRIDGE REGISTRY KEY FOR BACKUP

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server.

This is a safety precaution and will not affect users currently accessing the Insbridge system.

If you have to move RM/IBFA to a new machine or in the event of a catastrophic server failure, where the
RM/IBFA server is non-recoverable, the Insbridge system will need to be reinstalled. When RM/IBFA is
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re-installed on a new server, a new registry key will be created. The new registry key will not match the
registry key associated with any packages that have been created. In order to load packages to the new
server, you will need to restore the previous registry key.

You may also be requested to send to your registry key to support.

The preferred method to export is using IBFA.

To Export a Registry Using IBFA

When exporting the a registry key from the IBFA Ul, the system allows the customer sending the key to
generate a password so that only the receiver that has the password can import it.

The sender must provide the subscriber id, name, and description of the subscriber on the export. The
importing IBFA details must match and the password must be correct as well.

1. From the IBFA home page, click the configuration icon.

2. On the configuration details screen, Click export.

3. Enter the password for the Insbridge user where the current instance resides.

4. Save the registry to the location of your choice.

To Export on the RateManager/IBFA Machine

1. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.
2. Right click and select Export.
3. Select a storage location for the file and Save.

4. Close out of Registry Editor.

At the completion of this step, you may enter RateManager and begin working.
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Suggested Next Steps

e The Insbridge system is ready for administrators. Make sure database updates have been
performed.

- Users can be created and permissions assigned.
- Domains, domain types, and projects can be created.

e After user logins have been created, it is suggested that the RateManager Client Setup Guide be
sent to users along with their login information.

e SoftRater environments should be set up next.
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MANUAL UPDATES TO THE INSBRIDGE DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager and run the updates there. If the administrator has DB User privileges and is the
DB Owner of the database as well as the disk administrator, database updates can be done on
the Tools>Database>Updates tab. If these privileges are not in place, an error message will
be displayed. See
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Running Database Updates for instructions.

NOTE:

If you need to go from an older version, such as 03.13, it is strongly recommended that
you enter RateManager and run the script successively starting with 04.00, 04.01, and so
on until you reach the 05.06.00 script. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates in SQL Server using Query Analyzer.

1. Download the update scripts from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as
“current”. If you are going from a much lower version of RateManager, you will have to
save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file
to a location of your choice. For IBRM scripts, it is recommended that you rename the file
to usp_IBRM_R(version number).sql. For example the Release 05.06.00 update would
be: usp_IBRM_R05.06.00.sql. For IB_CLIENT scripts, it is recommended that you
rename the file to usp_IB_CLIENT_RO(version number).sql. For example the Release
05.06.00 update would be: usp_IB_CLIENT_R05.06.00.sql.

4. Verify that you have saved all the necessary scripts from “current” to release 05.06.00.
You must save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database.
Open Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program

you want, such as Notepad. Begin with the “current” script. For example, if you are going
from R04.08 to 05.06.00, 04.08 should be “current”. Open 04.08 first.
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R Microsoft SQL Server Management Studio
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Figure 46 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a
new Database Engine Query, File>New—->Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 05.06.00 update.

11. When you have finished updating one database, update the remaining database. Make
sure you do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed. The
updates are now properly applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view.
Click Open Update Script. The update script will be displayed in a separate screen.

& IBRE : v05.06.00.00 -- Webpage Dialog X
close
IF ((SELECT DATA TYPE FROM INFORMATION SCHEMA.COLUMNS WHERE TABLE NAME A
= 'PROGRAM VERSIONS' AND COLUMN NAME = 'VER') = 'int')
BEGIN
/* DROP ALL THE PK, FK AND INDEX CONSTRAINTS RELATED TO PROGRAM VER */
ALTER TABLE [dbo].[TABLE MANAGEMENT JOB DEFS] DROP CONSTRAINT
[PK_TABLE MANAGEMENT JOB DEFS]
ALTER TABLE [dbo].[TABLE MANAGEMENT JOB DEFS] DROP CONSTRAINT
[FK_TABLE MANAGEMENT JOB DEFS5_PROGRAM VERSIONS]
ALTER TABLE [dbo].[PROGRZM VERSIONS KEYS] DROP CONSTRAINT
[FK_PROGRAM VERSIONS_KEYS PROGRAM VERSIONS]
ALTER TABLE [dbo].[RELEASE PROGRAMS] DROP CONSTRAINT
[FK_RELEASE PROGRAMS_ PROGRAM VERSIONS]
ALTER TABLE [dbo].[PROGRZM LOCKUP_ VARS] DROP CONSTRAINT
[FK_PROGRAM LOOKRUPVARS PROGRAM VERSIONS] v

Figure 47 Script Viewer
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CREATING AN APPLICATION POOL

If the Insbridge application pool needs to be created, you can create one. The Insbridge
installation must be complete prior to creating an application pool. Make sure that Static Content
is enabled in the Server Manager Roles.

There are three steps to creating an Insbridge application pool and then assigning the virtual
directories.

e Step 1: Create or Verify an Insbridge Application Pool.
e Step 2: Verify settings.
e Step 3: Associate the Insbridge application pool with virtual directories IBFA, insbridge,
RM
1. Click Start > Administrative Tools - select IIS Manager.

2. Expand the Local Computer and select Application Pools. Right click and select Add
Application Pool.

™ Internet Information Services (115) Manager H=
@ & [ [} v SERVER » Application Pocks | 5& 3@ -
File  Yiew Help
rTTTT— - an lication Pools _
& -8 J App 2 add Application Paol. .
-6 Start Page Set Application Pool Defaults. .
E‘g-j SERVER This page lets you view and manage the list of application pools on the server, Application pools are associated with warker e—pplca i 0
£y o1 ntain one of mare applications, and provide isolation among different applications. .& Help
m}: Add Application Pool... | = - ;
| Sites —_—] = (G0 - hshow Al | Groupby: Mo Grouping - Online: Help
‘ M3 Refresh | Status | .MET Frame... | Managed Pipeli... | Identit | Applications |
,QASP.NET w40 Started w40 Inkegrated ApplicationPoollden... 0
‘;?ASP.NET wa,0 Classic Started w0 Classic ApplicationPoollden... 0
L=} Classic .MET AppPoal Started w20 Classic applicationPoollden... 0
QDeFau\tAppPool Started vz.0 Inkegrated ApplicationPoollden... 2

Ready Gi:i

Figure 48 Navigating to Application Pool
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3. Enter “Insbridge” for the Application pool Name. Select the v4.0 for the .NET Framework
version. Click OK. You will be returned to the IIS screen. Your new application pool is listed.

Add Application Pool E I

Marme:
IInsI:uriu:Ige

[MET Eramewark version:

MET Framewaork, v,

Managed pipeline mode:
IIntegrated j

v Skart application poal immediately:
(] 4 I Cancel

Figure 49 Creating a New Application Pool
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Step 2: Update Settings

1. Right click the Insbridge Application Pool you created and select Advanced Settings.

Advanced Settings H

y -
i JMET Framework, Version y4.0
Enable 32-Bit Applications False
Managed Pipeline Mode Inkeqrated
Marme IMNSERIDGE
Queus Length 1000
Skart Automatically True
E CrPu
Lirnit 1]
Limit: Action Modckion
Limit Inkerval (minutes) 5
Processar Affinity Enabled False —
Processar AFFinity Mask:, 4794957295
E Process Model
Identity Insbridge
Idle Time-out {minutes) 1]
Load User Profile False
PMaxirmum YWorker Processes 1
Pirng Enabled True
PFing Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shukdawn Tirme Limik (seconds) a0
Skartun Time Limik fosrnndst an hd
Mame
[mame] The application pool name is the unique identifier For the application poal.

Ik

Cancel |

4

Figure 50 Selecting Application Pool Properties

2. Verify that the .NET Framework Version is v4.0.

3. Verify the identity is Insbridge. If the identity is not Insbridge, you can update it. For the
Identity choose to use custom account and enter the same user that was used to install
Insbridge.

4. Click OK to save your changes.
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Step 3: Associate the web applications with the Insbridge Application Pool

Next, you will need verify or associate the Insbridge web applications with the new Insbridge
application pool.

1. Stayin IS Manager. Under Local Server 2 Sites = select IBFA, right click and select
Manage Application> Advanced Settings.

*E Internet Information Services (115) Manager [_ O]
@ L= 3 b SERVER P Sites » Defaulk WebSike » IBFA I i il l,@, -
Fie Yiew Help
_ &) [IBFA Home [
ﬁ.' o | |"_ |§, U] /I 2 Explore
&3 Start Page = Edit Permissions. ..
& €5 serven Filter: - fhe - Ghshowal |sroupby: area ~ - e
+ ) Application Paals ASP.NET A 5] Basic Settings...
E-lal %‘35 s . @ . Yiew Virtual Dirertories
13 Default Web Site = > - “i
> = ] — P
“ aspret_client % NF E o3 =W = ab Manage Application -~
S E MET (MET Error {NET METProfle  MET Trust  Application  Conmection i —
| Explore ampilation Pages Globalization Levels Settings Strings O
*
Edit Permissions. .. Broee 'SDEhEE“'W
— EE=S % a}l_. Advanced Settings. ..
Add application. .. Bl = m————
d  Session Stat SMTP E-mail (7]
© Add virtual Directory. .. Cag:r:;: ession State mal @ Help
Online Help
‘ Manage Application » ‘ Browse
k3  Refresh Adwanced Settings... | .
Remove =) = =l =S
(2 Switch to Content Yiew thorization  Compressian Default Directory Etror Pages Falled Request  Handler
Rules Dacument Erowsing Tracing Rules  Mappings
- B3, . ﬂ= = - S &=
& ; ] = o - =
CH = 7 & =
HTTP Redirect HTTP IP Address Lagging MIME Types Maodules Output Request
Respa... and Dom.... Caching Filtering
S50 Settings e
Management
— - [
E]Features Wiew |\ - Content View
Ready €

Figure 51 Associating the Virtual Directories with the Insbridge Application Pool

2. Under the General Settings - Application Pool, click the Application Pool entry field to see
the ellipsis (...) button.
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Advanced Settings E

B {General)
Application Pool DefaultAppPool
Phesical Path C:"PROGRAM FILES, ORACLEYINSEBRID
Phesical Path Credentials
Pheysical Path Credentials Logon Type  ClearText

Wirtual Path ITBF A
E Behavior
Enabled Protocaols http

select Application Pool Ed |

application pool:
IMSERIDGE

Properties:

Met Framework Yersion: 4.0
Pipeline mode: Integrated

(0] 4 I Cancel

Application Pool
[applicationPoal] Configures this application ko run in the specified application poal,

Ik Cancel |

4

Figure 52 Adding Application to Application Pool

3. Click the ellipsis button. A separate window is displayed.

4. Selectthe Insbridge Application Pool.

5. Click OK. Click OK again to close the Advanced Settings window.

6. Repeat for RM, and Insbridge.

7. Return to the Insbridge application pool. Right click and select to view the applications.
8. Right click to View Applications. The three Insbridge applications should be listed.

9. Select the server level above the application pools and restart IIS. On the IIS screen,
Actions>Restart IIS.
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" Internet Information Services (115) Manager [_ O]
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Figure 53 Restarting IIS
Application Pool Error

If you choose not to create an Insbridge Application Pool, the Insbridge application will use the
default application pool. If you receive an error when accessing IBFA for the first time after a new
install:

CS0016: Could not write to output file
‘c:\Windows\Microsoft. NET\Framework64\v2.0.50727\Temporary ASP.NET
Files\ibfa\783d6267\bccaOb3e\App_global.asax.zf-kqiii.dll": 'Access is denied. '

You may have to create a separate Insbridge Application Pool.
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CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Enterprise Rating System product,
please log a Service Request using My Oracle Support at https://support.oracle.com/.

Oracle customers have access to electronic support through My Oracle Support. For information,
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200

oracle.com
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